
Sun Microsystems, Inc.
www.sun.com

Send comments about this document to: docfeedback@sun.com

Sun StorEdge™ Traffic Manager 4.6
Software User’s Guide

For Microsoft Windows 2000 and 2003
and

Red Hat Enterprise Linux
Operating Systems

Part No. 819-0146-10
September 2004



Please
Recycle

Copyright 2004 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All rights reserved.

Sun Microsystems, Inc. has intellectual property rights relating to technology that is described in this document. In particular, and without
limitation, these intellectual property rights may include one or more of the U.S. patents listed at http://www.sun.com/patents and one or
more additional patents or pending patent applications in the U.S. and in other countries.

This document and the product to which it pertains are distributed under licenses restricting their use, copying, distribution, and
decompilation. No part of the product or of this document may be reproduced in any form by any means without prior written authorization of
Sun and its licensors, if any.

Third-party software, including font technology, is copyrighted and licensed from Sun suppliers.

Parts of the product may be derived from Berkeley BSD systems, licensed from the University of California. UNIX is a registered trademark in
the U.S. and in other countries, exclusively licensed through X/Open Company, Ltd.

Sun, Sun Microsystems, the Sun logo, AnswerBook2, docs.sun.com, Sun StorEdge, and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and in other countries.

All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC International, Inc. in the U.S. and in other
countries. Products bearing SPARC trademarks are based upon an architecture developed by Sun Microsystems, Inc.

The OPEN LOOK and Sun™ Graphical User Interface was developed by Sun Microsystems, Inc. for its users and licensees. Sun acknowledges
the pioneering efforts of Xerox in researching and developing the concept of visual or graphical user interfaces for the computer industry. Sun
holds a non-exclusive license from Xerox to the Xerox Graphical User Interface, which license also covers Sun’s licensees who implement OPEN
LOOK GUIs and otherwise comply with Sun’s written license agreements.

U.S. Government Rights—Commercial use. Government users are subject to the Sun Microsystems, Inc. standard license agreement and
applicable provisions of the FAR and its supplements.

DOCUMENTATION IS PROVIDED "AS IS" AND ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES,
INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT,
ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID.

Copyright 2004 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, Californie 95054, Etats-Unis. Tous droits réservés.

Sun Microsystems, Inc. a les droits de propriété intellectuels relatants à la technologie qui est décrit dans ce document. En particulier, et sans la
limitation, ces droits de propriété intellectuels peuvent inclure un ou plus des brevets américains énumérés à http://www.sun.com/patents et
un ou les brevets plus supplémentaires ou les applications de brevet en attente dans les Etats-Unis et dans les autres pays.

Ce produit ou document est protégé par un copyright et distribué avec des licences qui en restreignent l’utilisation, la copie, la distribution, et la
décompilation. Aucune partie de ce produit ou document ne peut être reproduite sous aucune forme, par quelque moyen que ce soit, sans
l’autorisation préalable et écrite de Sun et de ses bailleurs de licence, s’il y en a.

Le logiciel détenu par des tiers, et qui comprend la technologie relative aux polices de caractères, est protégé par un copyright et licencié par des
fournisseurs de Sun.

Des parties de ce produit pourront être dérivées des systèmes Berkeley BSD licenciés par l’Université de Californie. UNIX est une marque
déposée aux Etats-Unis et dans d’autres pays et licenciée exclusivement par X/Open Company, Ltd.

Sun, Sun Microsystems, le logo Sun, AnswerBook2, docs.sun.com, Sun StorEdge, et Solaris sont des marques de fabrique ou des marques
déposées de Sun Microsystems, Inc. aux Etats-Unis et dans d’autres pays.

Toutes les marques SPARC sont utilisées sous licence et sont des marques de fabrique ou des marques déposées de SPARC International, Inc.
aux Etats-Unis et dans d’autres pays. Les produits protant les marques SPARC sont basés sur une architecture développée par Sun
Microsystems, Inc.

L’interface d’utilisation graphique OPEN LOOK et Sun™ a été développée par Sun Microsystems, Inc. pour ses utilisateurs et licenciés. Sun
reconnaît les efforts de pionniers de Xerox pour la recherche et le développement du concept des interfaces d’utilisation visuelle ou graphique
pour l’industrie de l’informatique. Sun détient une license non exclusive de Xerox sur l’interface d’utilisation graphique Xerox, cette licence
couvrant également les licenciées de Sun qui mettent en place l’interface d ’utilisation graphique OPEN LOOK et qui en outre se conforment
aux licences écrites de Sun.

LA DOCUMENTATION EST FOURNIE "EN L’ÉTAT" ET TOUTES AUTRES CONDITIONS, DECLARATIONS ET GARANTIES EXPRESSES
OU TACITES SONT FORMELLEMENT EXCLUES, DANS LA MESURE AUTORISEE PAR LA LOI APPLICABLE, Y COMPRIS NOTAMMENT
TOUTE GARANTIE IMPLICITE RELATIVE A LA QUALITE MARCHANDE, A L’APTITUDE A UNE UTILISATION PARTICULIERE OU A
L’ABSENCE DE CONTREFAÇON.



Contents

Preface vii

Before You Read This Guide viii

How This Guide Is Organized viii

Typographic Conventions ix

Related Documentation x

Accessing Sun Documentation x

Contacting Sun Technical Support x

Sun Welcomes Your Comments xi

1. Sun StorEdge Traffic Manager Software Overview 1

About the Sun StorEdge Traffic Manager  Software 1

About Asymmetric Device Path Management 2

Vendor-Unique Asymmetric Devices 2

T10 ALUA Asymmetric Devices 3

About Symmetric Device Path Management 3

Switch Configurations 3

Description of Specific Fields 4

2. The Sun StorEdge Traffic Manager GUI Software 7

Understanding the Sun StorEdge Traffic Manager GUI 7
iii



Device and Status Icons 8

Working With Data Paths 9

Data Path States 10

Updating Path Status 10

Putting a Single Data Path Into admin Mode 10

Removing a Single Data Path From admin Mode 11

Activating Data Paths 12

Activating All Preferred Paths for a Storage Device 13

▼ To Activate All Preferred Paths for a Storage Device 13

Putting All Paths to a Particular HBA Into admin Mode 14

Removing All Paths to a Particular HBA From admin Mode 15

Getting Storage Device Information 16

Activating All Preferred Paths for a LUN 16

▼ To Activate All Preferred Paths for a LUN 16

Getting LUN Information 17

▼ To Get LUN Statistics 17

▼ To Get HBA Properties 18

Getting Path Statistics 20

▼ To Get Online Help 21

Setting the Software Preferences 22

Setting the Logging Level 22

▼ To Set the System Logging Level 22

Setting the Failback Mode 23

Symmetric Devices 24

T10 ALUA Asymmetric Devices 24

Vendor-Unique Asymmetric Devices 24

▼ To Set the Failback Mode 24

Setting the Poll Rate 25
iv Sun StorEdge Traffic Manager 4.6 Software Installation Guide for Windows and Linux • September 2004



▼ To Set the Poll Rate 26

3. Using the Sun StorEdge Traffic Manager CLI Software 29

Command-Line Interface Options 29

sstm Command Operations 31

Obtaining a Default Report 32

Device Reports 34

LUN Reports 36

Path Reports 38

Activating a Data Path 38

Putting a Path into admin Mode 39

Taking a Path Out of admin Mode 39

Getting Path Statistical Information 40

Getting HBA Reports 40

Getting Software Settings 43

Changing Software Settings 43

The Suspend Command 44

The Cancel Command 44

4. Logging Event Information 45

Accessing the Log Files 45

▼ To Access the Log Files for Microsoft Windows 2000 and 2003 45

▼ To Access the Log Files for Linux 46

Logging Levels 46

Windows Log Messages 47

Linux Log Messages 49

5. Error Return Messages 53

Index 55
v



vi Sun StorEdge Traffic Manager 4.6 Software Installation Guide for Windows and Linux • September 2004



Preface

The Sun StorEdge Traffic Manager 4.6 Software User’s Guide provides instructions for
using the Sun StorEdge™ Traffic Manager software in Microsoft Windows 2000
service pack 4, Microsoft Windows 2003 and Red Hat Enterprise Linux operating
environments.

This guide is designed for use with the Sun StorEdge Traffic Manager 4.6 Software
Installation Guide for Microsoft Windows and Red Hat Linux and the documentation that
came with your storage device. This guide is written for experienced system
administrators of Red Hat Enterprise Linux and Microsoft Windows 2000 Service
Pack 4 and 2003 operating systems and related disk storage systems.

Throughout this guide, storage device is used to designate the storage devices
supported in this release. The supported devices are:

■ Sun StorEdge T3B array

■ Sun StorEdge 3510 FC array

■ Sun StorEdge 6120 array

■ Sun StorEdge 6130 array

■ Sun StorEdge 6320 system

■ Sun StorEdge 6910/6960 systems

■ Sun StorEdge 6920 system

■ Sun StorEdge 9900 series

■ Devices complying with Asymmetric Logical Unit Access (ALUA), as defined in
the T10, SPC-3, Revision 17 working document, for devices that support implicit
only access management
vii



Before You Read This Guide
To fully use the information in this guide, you must have thorough knowledge of the
topics described in the documentation that came with your storage device.

How This Guide Is Organized
This guide is organized as follows:

Chapter 1 provides an overview of the Sun StorEdge Traffic Manager Software.

Chapter 2 explains the Sun StorEdge Traffic Manager Software GUI.

Chapter 3 explains the Sun StorEdge Traffic Manager command line interface.

Chapter 4 explains how to set logging for event information.

Chapter 5 describes the error messages that can be issued during software operation.
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Typographic Conventions

Typeface*

* The settings on your browser might differ from these settings.

Meaning Examples

AaBbCc123 The names of commands, files,
and directories; on-screen
computer output

Edit your.login file.
Use ls -a to list all files.
% You have mail.

AaBbCc123 What you type, when contrasted
with on-screen computer output

% su

Password:

AaBbCc123 Book titles, new words or terms,
words to be emphasized.
Replace command-line variables
with real names or values.

Read Chapter 6 in the User’s Guide.
These are called class options.
You must be superuser to do this.
To delete a file, type rm filename.
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Related Documentation

Accessing Sun Documentation
You can view, print, or purchase a broad selection of Sun documentation, including
localized versions, at:

http://www.sun.com/documentation

Contacting Sun Technical Support
If you have technical questions about this product that are not answered in this
document, go to:

http://www.sun.com/service/contacting

Application Title Part Number

Late-breaking Information Sun StorEdge Traffic Manager 4.6
Software Release Notes for Microsoft
Windows 2000 and 2003, and Red Hat
Enterprise Linux Operating Systems

819-0147-10

Installation Guide Sun StorEdge Traffic Manager 4.6
Software Installation Guide for Microsoft
Windows and Red Hat Linux

819-0145-10

Configuring the SAN Sun StorEdge SAN Foundation Software
4.4 Configuration Guide

817-3672-11
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Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your comments and
suggestions. You can submit your comments by going to:

http://www.sun.com/hwdocs/feedback

Please include the title and part number of your document with your feedback:

Sun StorEdge Traffic Manager 4.6 Software User’s Guide for Microsoft Windows 2000 and
2003, and Red Hat Enterprise Linux Operating Systems, part number 819-0146-10.
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CHAPTER 1

Sun StorEdge Traffic Manager
Software Overview

This chapter contains the following topics:

■ “About the Sun StorEdge Traffic Manager Software” on page 1

■ “Switch Configurations” on page 3

■ “Description of Specific Fields” on page 4

About the Sun StorEdge Traffic Manager
Software
The Sun StorEdge Traffic Manager software is a system for managing multiple paths
to storage devices. The Sun StorEdge Traffic Manager system consists of a graphical
user interface (GUI), a command line interface (CLI), and system device drivers for
managing the multiple paths. If a failure occurs in one host data path, the Sun
StorEdge Traffic Manager software automatically detects the failure and provides
continuous access to data through an alternate data path.

Each storage device and the LUNs associated with it are shown on the left side of
the window and the paths and host bus adapters (HBA) system names are shown on
the right.
1



About Asymmetric Device Path Management
The Sun StorEdge Traffic Manager 4.6 software supports two types of asymmetric
device path management: vendor-unique and T10 Asymmetric Logical Unit Access
(ALUA) device path management. The asymmetric devices that are listed on page
vii are managed with vendor-unique commands. Additionally, devices that are not
specifically listed, yet comply with implicit ALUA as defined in the T10, SPC-3,
Revision 17 working document, are managed according to the T10 specification.

Vendor-Unique Asymmetric Devices

The following description of failover and failback operations apply to vendor
specific asymmetric devices.

■ Failover – A logical unit number (LUN) on an asymmetric device can have only
one active controller at a time. The controller that is not active is known as the
passive controller. Paths to the active controller are known as active paths; paths
to the passive controller are known as passive paths.

The process by which a LUN can force a passive controller to become its active
controller is known as LUN failover. When LUN failover occurs, passive paths to
a controller become active, and previously active paths become passive. On the
Sun StorEdge™ T3 and Sun StorEdge 6120 arrays, failover is implemented per
device volume. Therefore, if volume slicing is enabled, multiple LUNs on the
volume can be affected by a failover. Also, in a multi-initiator environment, a
LUN failover on one host affects all other hosts using LUNs on the same volume.
LUN failover can be initiated by both automatic and manual means.

■ Automatic failover by error detection – If a path receives errors and fails, it is
marked as Down or Removed. If all the active paths for a LUN are marked Down
and there are remaining passive paths, the driver automatically causes a LUN
failover to activate the passive paths.

■ Manual failover initiated by the activate command – The user can use the
activate command to manually initiate a LUN failover by activating a passive
path, causing previously active paths to become passive. On the Sun StorEdge T3
and Sun StorEdge 6120 arrays, if the LUN is a slice on a volume, all LUNs on that
volume will fail over for all hosts.

■ Manual failover initiated by the restore command – On some devices, a LUN
may have a default active controller, known as the preferred controller. A
restore command initiates a failover of all LUNs that are not currently being
accessed by way of their preferred controller.

■ Automatic failback initiated by an automatic restore – If the autofailback
parameter is set to enabled, the restore command is initiated automatically
when the software recognizes that a down path has becomes passive. This is
known as autofailback. The autofailback parameter must be set to enabled in
order for this to occur.
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For information on configuring and using the autofailback command, refer to
“Setting the Failback Mode” on page 23.

Note – The autofailback parameter is not supported in a multi-initiator
environment.

T10 ALUA Asymmetric Devices

When using T10 ALUA asymmetric devices, only implicit logical unit access is
supported. With implicit access, the device’s controller manages the states of path
connections. The Sun StorEdge Traffic Manager software can monitor the path states
but cannot change them, either automatically or manually. Paths can either be active
or standby. Of the active paths, a path may be specified as preferred (optimized in
T10), and as non-preferred (non-optimized). If there are active preferred paths, then
only these paths will receive commands, and will be load balanced to evenly
distribute the commands. If there are no active preferred paths then the active non-
preferred paths are used in a round-robin fashion. If there are no active non-
preferred paths then the LUN cannot be accessed until the controller activates its
standby paths.

About Symmetric Device Path Management
For symmetric devices, all paths are active unless a path is unhealthy and
designated as down, in which case the unhealthy path is rerouted. Load balancing
occurs across all active paths to improve performance by using all available paths to
a storage device.

Switch Configurations
The Sun StorEdge Traffic Manager software works with storage device
configurations that include switches. For information on configuring storage devices
with switches, refer to the documentation for the switch you are using.
Chapter 1 Sun StorEdge Traffic Manager Software Overview 3



Description of Specific Fields
Throughout its operation, the Sun StorEdge Traffic Manager software presents
information about devices, properties, paths, and metrics using specific fields.
TABLE 1-1 lists the specific fields and a description of the contents.

TABLE 1-1 Specific Fields

Specific Field Contents

Auto Failback Controls how the software responds when a failed path comes back
online or is re-established. When a failed path is repaired or returns
from a down state, it is always re-enabled but not always activated.
When auto failback is enabled and the path is the preferred path, it is
automatically re-activated. Note that auto failback is only supported
in a single-host environment.

Blocks Transferred Displays the number of I/O read or write blocks transferred to and
from the storage device. These values are only maintained from the
last host boot. They are not persistent across a reboot of the host.

Capacity Storage capacity of the LUN.

Device Description Displays one of the Sun devices in the following list:
• Sun StorEdge T3B array
• Sun StorEdge 3510 FC array
• Sun StorEdge 6120 array
• Sun StorEdge 6130 array
• Sun StorEdge 6320 system
• Sun StorEdge 6910/6960 systems
• Sun StorEdge 6920 system
• Sun StorEdge 9900 series

For devices that are not listed above, yet comply with T10 ALUA,
this field displays the inquiry data Vendor ID and Product ID fields.

Enabled or Active The state field can contain the following states:
• ACTIVE – indicates that the device is Enabled and Active
• PASSIVE – indicates that the device is Enabled, but not Active
• STANDBY – indicates that the device not Enabled, nor Active
• ADMIN – indicates that the device is not Enabled, nor Active
• DOWN – indicates that the device is neither Enabled, nor Active
• TRANSITIONING – state is changing
• UNKNOWN – cannot be determined
• REMOVED – indicates that the device is neither Enabled, nor Active
4 Sun StorEdge Traffic Manager 4.6 Software User’s Guide • September 2004



Error Returns Indicates that an error has been returned. Information on returned
errors is located in Chapter 5.

Firmware Revision Displays the high-level firmware that is currently installed on the
storage device.

HBA Displays the name of an HBA according to the conventions of your
operating environment.

Host Requests Displays the number of I/O requests that the upper-level drivers
have given to the Sun StorEdge Traffic Manager software. These
values are only maintained from the last host boot. They are not
persistent across a reboot of the host.

I/O Errors Displays the number of errors handled by the failover driver for the
specified LUN. These values are only maintained from the last host
boot. They are not persistent across a reboot of the host.

IP Address Displays the management IP address for the Sun StorEdge storage
device, if available.

Log Level Determines the messaging detail that is sent to the host system log.
Multiple log levels can be ORed together. All log levels can be turned
on by specifying 0x1F from the CLI.

LUN Name Field The operating-system specific name for the specified LUN. If the
operating LUN name cannot be determined, it is presented as LUN.

LUN State The LUN states are:
• Up

• Down

• Waiting for an active path

• Transitioning

• Removed (for Windows platforms only)
• Unknown

LUN Unique ID Displays a number unique to each LUN that indicates connection to
the host.

Nexus Name Displays the nexus name for the HBA to storage device controller.
The nexus name is defined by the Sun StorEdge Traffic Manager
software. The format varies with each supported operating system.

Outstanding I/Os Displays the number of I/Os that have been sent to the device but
have not been completed. This value is comparable to the I/O queue
depth from this host to a given LUN. These values are only
maintained from the last host boot. They are not persistent across a
reboot of the host.

Pathing Mode This field displays the pathing mode that can be used by the device,
which is either symmetric, asymmetric or ALUA-implicit.

TABLE 1-1 Specific Fields (Continued)

Specific Field Contents
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Poll Rate Healthy poll rate determines how often the software checks the
status of paths that are not down and are currently available.
Unhealthy poll rate determines how often the software checks
the status of paths that are down.

Single Character
Column

On the left side of the information produced by the command line
interface is a column that has an asterisk (*) as the column head.
This column contains warning and error states if they exist. The
possible values in this column are:
‘ ‘ – No warnings
X – The path is down or removed
! – The path is not active and is the preferred path
! – The path is in admin mode
- (hyphen) – The path is in transition
? – The path is in an unknown state

Storage Device Defined as a collection of LUNs contained by a specific storage
product (for example, a Sun StorEdge 6120 partner pair). If a storage
system cannot be determined, LUNs are put in collections based on
their SCSI INQUIRY VENDOR/PRODUCT/SERIAL values. For
example, a third-party storage device that is attached though Sun
Solaris Open-MpxIO.

Unique ID A internal identification that is used to associate LUNs to a specific
storage device.

Worldwide Name
(WWN)

A unique number assigned to each device.

TABLE 1-1 Specific Fields (Continued)

Specific Field Contents
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CHAPTER 2

The Sun StorEdge Traffic Manager
GUI Software

This chapter describes the Sun StorEdge Traffic Manager GUI software and its uses.
This chapter contains the following topics:

■ “Working With Data Paths” on page 9
■ “Working With Data Paths” on page 9
■ “Getting Storage Device Information” on page 16
■ “Setting the Software Preferences” on page 22

Understanding the Sun StorEdge Traffic
Manager GUI
This section describes the Sun StorEdge Traffic Manager GUI and explains the
purpose of the various icons meanings.

When the Sun StorEdge Traffic Manager GUI starts, the Sun StorEdge Traffic
Manager window, as shown below, is displayed. In a device tree on the left of the
window is a list of supported storage devices attached to the current host and the
LUNs contained in each of those storage devices. The first storage device is always
selected and the information about that storage device is displayed on the right of
the window. The right of the window contains:

■ Type of device
■ Unique ID
■ IP address
■ Firmware revision
■ Name of the host the storage device is attached to
7



The names used in the device tree are the operating system-specific names for the
particular storage devices and LUNs.

If the name of a storage device cannot be obtained, “storage device” is used for the
name on the left of the window. If a LUN name cannot be obtained, “LUN” is used
for the LUN name.

If the Sun StorEdge Traffic Manager driver or library files are not installed and
working properly, the left of the window displays a message indicating improper
installation.

If no storage devices are attached, the left of the window displays a message
indicating that no storage devices are attached.

Device and Status Icons
The left of the Sun StorEdge Traffic Manager GUI window shows storage device and
the LUNs contained in each using the following icons.

The name of the storage device known to the Sun StorEdge Traffic
Manager software.

The LUNs that are contained in each of the storage devices.

Removed icon for a path, storage device, or LUN that is removed and
needs attention.
8 Sun StorEdge Traffic Manager 4.6 Software User’s Guide • September 2004



The following status icons indicate that a storage device, LUN or path needs
attention. For example, if a LUN is not able to allow I/O due to path conditions or it
contains a broken path, the critical icon is layered on top of the LUN icon and
storage device icon. Or, if a LUN has failed over and not in its normal state, the
minor icon is layered on top of the LUN and the storage device icon

Working With Data Paths
This section describes how to manipulate a data path between the host and the
storage device. The following changes can be made to the data path:

■ Removing a data path from admin mode
■ Putting a data path into admin mode
■ Activating a data path (not applicable to ALUA)
■ Activating all preferred data paths for a storage device (not applicable to ALUA)
■ Activating all preferred data paths for a particular LUN (not applicable to ALUA)
■ Removing all data paths to a particular HBA from admin mode,
■ Putting all data paths to a particular HBA into admin mode,

Minor icon for a path, storage device, or LUN that might need
attention.

Critical icon for a path, storage device, or LUN that is down or
broken and needs attention.

Icon that indicates the path is in transition.

Icon that is displayed if the status of the path is unknown
Chapter 2 The Sun StorEdge Traffic Manager GUI Software 9



Data Path States
The Path table contains a column labeled State. Each path listed in this column will
have the following states:

■ Active, it the path is active
■ Passive, if the path is healthy but not active
■ Admin, if the path has been put into admin mode and is not being considered for

I/O
■ Transition, if the state of the path is changing
■ Down, if the path is broken and needs repair
■ Standby, the path is healthy yet cannot be activated manually. (This state applies

only for ALUA-Implicit devices.)
■ Unknown, if the state of the path cannot be determined
■ Removed, if a Downed path that has been removed as a Windows Plug & Play

Device. (This state applies only for the Windows 2000 and 2003 operating
systems.)

Updating Path Status
When the Sun StorEdge Traffic Manager software detects a change in the status for a
path (for example, a path goes down, fails over, or the user disconnects a cable), it
sends a message to the Sun StorEdge Traffic Manager GUI to update. The GUI gets
the updated information from the software and displays the new status.

The information displayed by the GUI automatically updates when the state of a
path changes. However, if you don’t want to wait (for example, a long poll rate has
been specified or you think the data displayed is out-of-date), you can quickly
update the information displayed by the GUI in one of two ways:

■ Choose Refresh under the File menu
■ Press the F5 key

Putting a Single Data Path Into admin Mode
Putting a data path into admin mode prevents all normal I/O from using the path.
For example, you might want to put a path in admin mode to perform maintenance
on a component in the data path. A path must be in passive mode before it can be
put into admin mode.

See “Removing a Single Data Path From admin Mode” on page 11 to remove a data
path from admin mode.
10 Sun StorEdge Traffic Manager 4.6 Software User’s Guide • September 2004



▼ To Put a Data Path Into admin Mode

1. From the device tree on the left of the window, select the LUN that contains the
path you want to put into admin mode.

2. Select the path that you want to put into admin mode.

3. Choose To Admin from the Path menu.

Note – Alternatively, you can right-click the path and select the action from the pop-
up menu.

A dialog box is displayed to indicate the path is being put into admin mode and that
you should wait until the operation is complete.

Removing a Single Data Path From admin Mode
Removing a data path from admin mode does not guarantee that the path will
become active. For example, a path that is down due to a defective cable, stays down
after being removed from admin mode if the cable is still defective.

▼ To Remove a Data Path From admin Mode

1. From the device tree on the left of the window, select the LUN that contains the
path you want to remove from admin mode.

2. Select the path that you want to remove from admin mode.
Chapter 2 The Sun StorEdge Traffic Manager GUI Software 11



3. Choose Remove Admin from the Path menu.

Note – Alternatively, you can right-click the path and select the action from the pop-
up menu.

A dialog box is displayed to indicate that the path is being removed from admin
mode and that you should wait until the operation is complete.

Activating Data Paths
A data path must be healthy but not active (that is, passive) before it can be
activated. Standby paths cannot be activated.

▼ To Activate a Single Data Path

1. From the device tree on the left of the window, select the LUN that contains the
path you want to activate.

2. Select the path that you want to activate.
12 Sun StorEdge Traffic Manager 4.6 Software User’s Guide • September 2004



3. Choose Activate from the Path menu.

Note – Alternatively, you can right-click the path and select the action from the pop-
up menu.

A dialog box is displayed to indicate that the path is being activated and that you
should wait until the operation is complete.

Activating All Preferred Paths for a Storage
Device
You can activate all preferred paths for a particular storage device if that device has
preferred paths. Preferred paths are determined by the Sun StorEdge Traffic
Manager software and are based on device type and connection. The preferred path
is the optimal path to a device. The preferred path must be healthy but not active
(that is, passive) before it can be activated.

▼ To Activate All Preferred Paths for a Storage
Device

1. Select a storage device in the device tree on the left of the window.
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2. Choose Activate preferred paths from the Device menu.

A dialog box is displayed to indicate that all preferred paths are being activated and
that you should wait until the operation is complete.

Putting All Paths to a Particular HBA Into admin
Mode
If you want to perform maintenance on a specific HBA, to which you have several
storage devices connected, you can put all paths to a particular HBA into admin
mode.

▼ To Put All Paths to a Particular HBA Into admin Mode

1. Select the LUN that has a path using the particular HBA you are interested in.

2. From the path table on the right of the window, select the path that is using the
HBA you are interested in.

3. Choose Put ll paths in admin mode from the HBA menu.
14 Sun StorEdge Traffic Manager 4.6 Software User’s Guide • September 2004



Note – Alternatively, you can right-click the path and select the action from the pop-
up menu.

A dialog box is displayed to indicate that all paths to a particular HBA are being put
into admin mode and that you should wait until the operation is complete.

Removing All Paths to a Particular HBA From
admin Mode
You can remove from admin mode all paths to a particular HBA after you have
swapped out or repaired the component in the path to this HBA.

▼ To Remove All Paths to a Particular HBA From admin
Mode

1. From the device tree on the left of the window, select the LUN that has a path
using the particular HBA you are interested in.

2. Select the path that is using the HBA you are interested in.

3. Choose Remove all paths from admin mode from the HBA menu.

Note – Alternatively, you can right-click the path and select the action from the pop-
up menu.

Adialog box is displayed to indicate that all paths to a particular HBA are being
removed from admin mode and that you should wait until the operation is
complete.
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Getting Storage Device Information
When the Sun StorEdge Traffic Manager GUI starts, the storage device and the
operating-system-specific names for the storage device are selected on the left of the
window. On the right of the window is detailed information about that storage
device.

To get this detailed information about any storage device shown on the left of the
window, select that storage device by clicking on it.

Activating All Preferred Paths for a LUN
You can activate all preferred paths for a particular LUN if the LUN belongs to a
storage device that has preferred paths. Preferred paths are determined by the Sun
StorEdge Traffic Manager software and are based on device type and connection.
The preferred path is the optimal path to a device. The preferred path must be
healthy but not active (that is, passive) before it can be activated.

▼ To Activate All Preferred Paths for a LUN
1. Select a LUN in the device tree on the left of the window.

2. Choose Activate preferred paths from the LUN menu.

A dialog box is displayed to indicate that all preferred paths for the LUN are being
activated and that you should wait until the operation is complete.
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Getting LUN Information
To get information about a particular LUN, select the LUN icon on the left of the
window by clicking on it. The LUN information is displayed on the right of the
window. Some of the information is in a path table and other information is shown
above the table. The following information is above the table:

■ The operating system-specific name of the LUN
■ Unique ID of the LUN
■ Type of pathing mode: symmetric, asymmetric or ALUA-Implicit
■ LUN state
■ Storage capacity of the LUN

In the path table, all paths to the LUN are displayed. If any path needs attention,
either the minor icon or the critical icon is displayed beside the information in the
path table.

▼ To Get LUN Statistics
To get I/O statistics for a particular LUN, perform the following:

1. From the device tree on the left of the window, select the LUN for which you want
statistics.
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2. Choose Statistics from the LUN menu.

A dialog box is displayed containing the statistics of the selected LUN.

▼ To Get HBA Properties
To get information about the properties of an HBA that is in the path of a particular
LUN, perform the following steps:

1. Select the LUN from the device tree on the left of the window that has a path
using the particular HBA you are interested in.
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2. Select the path in the path table that is using the HBA you are interested in.

3. Choose Properties from the HBA menu.

A dialog box is displayed containing the properties of the selected HBA.
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Getting Path Statistics
To display path information and statistics, such as the number of host requests, and
I/O errors, peform the following steps:

▼ To Get Path Statistics

1. From the device tree on the left of the window, select the LUN that contains the
path you are interested in.

2. Select the path for which you want to view statistics.

3. Choose Statistics from the Path menu.
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A dialog box is displayed that contains the selected path statistics. The statistics in
the dialog box do not change dynamically. Click the Refresh button to get updated
statistics.

Note – Alternatively, you can right-click the path and select the action from the pop-
up menu.

▼ To Get Online Help
● Choose User’s Guide from the Help menu to display the Sun StorEdge Traffic

Manager 4.6 Software User’s Guide for online help. Select Installation Guide to
display the Sun StorEdge Traffic Manager 4.6 Installation Guide.
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Setting the Software Preferences
This section describes how to configure the preferences for the Sun StorEdge Traffic
Manager software. The following preferences can be configured:

■ Logging level
■ Failback mode
■ Poll rates

Setting the Logging Level
The logging level is determined for the Sun StorEdge Traffic Manager software on a
per system basis. That is, setting the logging level sets it for all devices attached to
the specified host. This enables you to control what level of messages you want to
put into the operating system’s log file.

For information on viewing logs, refer to Chapter 4.

▼ To Set the System Logging Level
1. Choose Preferences from the File menu.

2. Select the desired log level options in the Host Preferences dialog box.

The Host Preference dialog box displays a list of the logging levels.
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3. Click OK for the selected items to take effect.

If you do not want to save the changes made, click the Cancel button.

If you want to see the default settings for the Log Levels, click the Factory Defaults
button.

The updated settings take effect unless you click OK.

Note – Be aware that by clicking the Factory Defaults button, you are also setting
Failback Mode and Poll Rate to the factory default settings.

Setting the Failback Mode
After the failover of a data path, the specified failback mode determines how the
data path is changed from the alternate data path back to the preferred data path.

When a data path has failed over, the settings specified in the Failback Mode Host
Preferences field determine how the data path is modified from the alternate data
path back to the preferred data path.
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Symmetric Devices

Failback is not configured for symmetric devices. Any path that has failed over is
added back into the load balancing path pool.

T10 ALUA Asymmetric Devices

Neither automatic nor manual failback can be configured for T10 ALUA devices.
The device controller manages the path modes.

Vendor-Unique Asymmetric Devices

The failback mode is set for the Sun StorEdge Traffic Manager software on a per
system basis. That is, setting the failback mode sets it for all devices attached to the
current host.

You can specify two failback modes for these devices:

■ Manual failback – You can also manually fail back the data path for a storage
device to its preferred data path. First, ensure that the Sun StorEdge Traffic
Manager software is configured for manual failback.

■ Automatic failback – You can configure the Sun StorEdge Traffic Manager
software to automatically fail back to the preferred data path when that path
becomes operational. By default, automatic failback is not enabled.

Note – Automatic failback is only supported in a single-host environment.

▼ To Set the Failback Mode
1. Choose Preferences from the File menu.
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2. In the Host Preferences dialog box, choose the desired failback mode from the
Failback Mode menu.

3. Click OK for the selected item to take effect.

If you do not want to save the changes you made, click the Cancel button.

If you want to see the factory default settings, click the Factory Defaults button. The
factory default will be displayed in the Failback Mode field.

The updated settings take effect unless you click OK.

Note – Be aware that by clicking the Factory Defaults button, you are also setting
the Logging level and Poll Rate to the factory default settings.

Setting the Poll Rate
The Healthy Path Poll Rate field determines how often the Sun StorEdge Traffic
Manager software checks the status of paths that are not down or removed and are
currently available for I/O.
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The Unhealthy Path Poll Rate field determines how often the Sun StorEdge Traffic
Manager software checks the status of paths that are down or removed. If failback
mode is set to automatic and the Sun StorEdge Traffic Manager software finds that
the preferred path is operational after polling, the Sun StorEdge Traffic Manager
software fails back to the preferred path.

The poll rate is set for the Sun StorEdge Traffic Manager software on a per system
basis. That is, setting the polling rate sets it for all devices attached to the current
host.

▼ To Set the Poll Rate
1. Chose Preferences from the File menu.
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2. In the Host Preferences dialog box, choose the desired poll rate from the Poll Rate
menu.

Select Unhealthy Poll Rate to identify how often (in seconds) the software will check
the status of paths that are down or removed.

Select Healthy Poll Rate to identify how often (in seconds) the software will check
the status of paths that are available for I/O.

3. Click OK for the change to take effect.

If you do not want to save the change you made, click the Cancel button.

If you want to see the factory default setting, click the Factory Defaults button.

The updated settings take effect unless you click OK.

Note – Be aware that by clicking the Factory Defaults button, you are also setting
the Logging level and Failback Mode to the factory default settings.
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CHAPTER 3

Using the Sun StorEdge Traffic
Manager CLI Software

This chapter describes the uses of the Sun StorEdge Traffic Manager command line
interface (CLI) software.

The Sun Sun StorEdge Traffic Manager CLI described in this chapter is named sstm.
The sstm command has similar function to the Sun StorEdge Traffic Manager GUI
interface described in Chapter 2. The CLI enables you to collect basic path and
software state information and to manage path states and software settings.

This chapter contains the following topics:

■ “Command-Line Interface Options” on page 35
■ “sstm Command Operations” on page 37

Command-Line Interface Options
TABLE 3-1 contains an overview of all the options available for the sstm command

Note – The sstm command options are case-sensitive.

TABLE 3-1 sstm Command Options

Command Option Description

sstm None This default command displays information about
all devices

-v Displays information about all devices (verbose)

-d device_id Displays information about the specified device
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-d device_id -v Displays verbose information about the specified
device

-d device_id -r Restores all preferred paths for all LUNs for the
specified device

-l lun_id Displays information for a specified LUN

-l lun_id -v Displays verbose information for a specified LUN

-l lun_id -r Restores the preferred path for the specified LUN

-l lun_id -m Displays statistics for the specified LUN

-l lun_id -m -v Displays verbose statistics for the specified LUN

-p name Queries information for the specified path

-p name -v Queries verbose information for the specified path

-p name -a Activates the specified path

-p name -e Enables the specified path (take out of admin mode)

-p name -d Disables the specified path (place into admin mode)

-p name -m Displays statistics for the specified path

-p name -m -v Displays verbose statistics for the specified path

-h name Query information for this HBA

-h-name -v Query verbose information for this HBA

-h-name -e Enable all paths on this HBA (take out of admin
mode)

-h name -d Disable all paths on this HBA (place into admin
mode)

-P Displays public parameters

-P -r Restores default settings

-P -i seconds Sets the healthy path poll rate to the specified
number of seconds (from 2 through 3600 seconds)

-P -b seconds Set the unhealthy path poll rate to the specified
number of seconds (from 2 through 60 seconds)

TABLE 3-1 sstm Command Options (Continued)

Command Option Description
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For a description of the specific fields shown in these examples, see “Description of
Specific Fields” on page 3.

In the case of a failure of a command, a variety of meaningful messages are returned.
To view a list of error messages, see Chapter 5.

sstm Command Operations
The following examples show the operations of the sstm command and the
expected output.

Topics in this section include:

■ “Obtaining a Default Report” on page 38
■ “Device Reports” on page 40
■ “LUN Reports” on page 42
■ “Path Reports” on page 44
■ “Getting Software Settings” on page 50
■ “Changing Software Settings” on page 50
■ “The Suspend Command” on page 51
■ “The Cancel Command” on page 51

-P -l hex_value Sets the following log levels to determine what
information to log:
• 0x00 = no logging
• 0x01 = data path changes
• 0x02 = internal errors
• 0x04 = critical errors
• 0x08 = informational messages
• 0x10 = caution messages
• 0x1f = log everything

-P -a integer Sets the following integers to enable or disable auto
failback:
• 1 = enable
• 0 = disable

-S Suspends command return until a state change
occurs (for example, path up or path down).

-C Cancel the suspend command and return to the
user.

TABLE 3-1 sstm Command Options (Continued)

Command Option Description
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Obtaining a Default Report
This section shows the default report that is created by typing the sstm command
with no options specified. The following example is a sample output taken from a
Microsoft Windows host with one storage device with two LUNs, each available to
the host. All LUNs are attached to the host through two redundant paths. On other
operating systems the output is nearly identical with the exception of the operating
system device names, path names, and HBA names presented.
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CODE EXAMPLE 3-1 sstm Command Default Report

sstm

Device: storage device
  Device Name:       t3mojo.Central.Sun.COM
  Failover Capable:  yes
  Device Desc:       Sun StorEdge T3B Disk Array
  Unique Id:         60020f20000069960000000000000000
  IP Address:        172.20.24.100
  Firmware Revision: 0201

  LUN: \\.PhysicalDrive4
    Unique Id:                 60020f20000069963ee74a2a000829f6
    Serial Number              00535030
    Capacity:                  5.00GB
    State:                     UP
    Pathing Mode:              Asymmetric-MPXIO

    Paths to this LUN:
Cntr

* Path HBA State Pref
- ------------------- ------------------- --------------- ---

2,1,0,6 \\.\Scsi2: ACTIVE yes
    ! 3,1,0,6             \\.\Scsi3:          ADMIN           no

  LUN: \\.PhysicalDrive3
    Unique Id:                 60020f20000069963edb185e00033644

Capacity:                  10.00GB
    State:                     UP
    Pathing Mode:              Asymmetric-MPXIO

    Paths to this LUN:
Cntr

* Path HBA State Pref
- ------------------- ------------------- --------------- ---

    ! 2,1,0,3             \\.\Scsi2:          ADMIN           no
3,1,0,3 \\.\Scsi3: ACTIVE yes
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Device Reports
This section describes the device reports that can be run on a storage device. For the
device report, a storage device is defined as a collection of LUNs contained by a
specific storage product (for example, a Sun StorEdge 6120 array).

The report generated by the sstm -d device_id is a subset of the default report that
shows only the information about the device specified and its associated LUNs and
paths.
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In addition to the ability to limit a report to a specific device, the -d option can be
used with the additional argument of -r to restore all the preferred paths to all the
LUNs in this system. Refer to TABLE 3-1 for the correct syntax.

If the command restores all the LUNs on the device to their preferred path, a
successful message is displayed.

CODE EXAMPLE 3-2 Specific Device Report

sstm -d 60020f20000069960000000000000000

Device: storage device
  Device Name:       t3mojo.Central.Sun.COM
  Failover Capable:  yes
  Device Desc:       Sun StorEdge T3B Disk Array
  Unique Id:         60020f20000069960000000000000000
  IP Address:        172.20.24.100
  Firmware Revision: 0201

  LUN: \\.PhysicalDrive4
    Unique Id:                 60020f20000069963ee74a2a000829f6

Capacity:                  5.00GB
    State:                     UP
    Pathing Mode:              Asymmetric-MPXIO

    Paths to this LUN:
Cntr

* Path HBA State Pref
- ------------------- ------------------- --------------- ---

2,1,0,6 \\.\Scsi2: ACTIVE yes
    ! 3,1,0,6             \\.\Scsi3:          ADMIN           no

  LUN: \\.PhysicalDrive3
    Unique Id:                 60020f20000069963edb185e00033644
    Serial Number              00210500
    Capacity:                  10.00GB
    State:                     UP
    Pathing Mode:              Asymmetric-MPXIO

    Paths to this LUN:
Cntr

* Path HBA State Pref
- ------------------- ------------------- --------------- ---

    ! 2,1,0,3             \\.\Scsi2:          ADMIN           no
3,1,0,3 \\.\Scsi3: ACTIVE yes
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The following is an example of a command completing successfully:

LUN Reports
This section describes the LUN reports and the types of reports the options produce
when they are used with this command. The report generated by the sstm -l
lun_id command is a subset of the default report that shows only the information
about the specified LUN and its associated paths.

The following is an example of the output from this option

In addition to the ability to limit a report to a specific LUN, the -l option can be
used with the additional argument of -r to restore all the preferred paths to a LUN.

CODE EXAMPLE 3-3 Successful Completion of sstm -d Command

sstm -d 60020f20000072250000000000000000 -r
The operation completed successfully. (0)

CODE EXAMPLE 3-4 Specific LUN Report

sstm -l 60020f20000077043f1c0b0800007720
  LUN: \\.PhysicalDrive3
    Unique Id:                 60020f20000077043f1c0b0800007720

Capacity:                  11.00GB
    State:                     UP
    Pathing Mode:              Asymmetric-MPXIO

    Paths to this LUN:
Cntr

* Path HBA State Pref
- ------------------- ------------------- --------------- ---

      3,0,0,1             \\.\Scsi3:          ACTIVE          no
! 3,0,10,1 \\.\Scsi3: PASSIVE yes
! 4,0,16,1 \\.\Scsi4: PASSIVE yes

      4,0,19,1            \\.\Scsi4:          ACTIVE          no
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The following is an example using the -v (Verbose) option.

The -l option of the LUN commands also has the option similar to the Device
command to restore a LUN’s path to the preferred controller. The In Use column
indicates which path was the last path used to send I/O to the device.

The following is an example of a -l command completing successfully.

The -m option returns statistical information about the LUN. The following is an
example from this option and the verbose option:

CODE EXAMPLE 3-5 Verbose Option Specified

sstm -l  60020f20000069963edb1844000d9214 -v

  LUN: \\.PhysicalDrive2
    Unique Id:                 60020f20000069963edb1844000d9214

Capacity:                  10.00GB
    State:                     UP
    Pathing Mode:              Asymmetric-MPXIO

    Paths to this LUN:
Cntr  In

* Path HBA State Pref Use
- ------------------- ------------------- --------- --- ----

      2,1,0,2             \\.\Scsi2:          ACTIVE yes  yes
        state:ACTIVE numOut=0 flags:0x7
      3,1,0,2             \\.\Scsi3:          PASSIVE no   no
        state:PASSIVE numOut=0 flags:0x2

sstm -l 60020f20000072250000000000000000 -r
The operation completed successfully. (0)

CODE EXAMPLE 3-6 With Statistical and Verbose Options Specified

sstm -l 60020f20000072253dad916300061f41 -m -v
LUN Statistics:

LUN: 60020f20000072253dad916300061f41
Host Requests: 198
Outstanding IO: 0
Blocks Transferred: 1682
IO Errors: 0
Temp Dropouts: 0
HW Dropouts: 0
Full Dropouts: 0
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Path Reports
The basic Path Report returns information about a specific path. The report
generated by the sstm -p name command is a subset of the default report that
only shows the information about the path specified.

This report contains a nexus name for the HBA to storage device controller. In these
examples, it is noted by 3,0,10,1. The nexus name is defined by the failover
software.

The following is an example of the Path Report:

Activating a Data Path

The -a Path command option activates a path that is passive. When this option is
used, a message indicating success is sent if the command is successful. Otherwise,
an error message is issued. A list of all messages is described in Chapter 5.

The following example of the -a option builds on the sstm -p example. It uses the
-a option to activate a path. The success of the command can be verified by running
a second Path Report to list the results. In the second Path Report, the State status
is reported as ACTIVE.

CODE EXAMPLE 3-7 Path Report Output

sstm -p 3,0,10,1
Cntr

* Path HBA State Pref
- ------------------- ------------------- --------------- ---
! 3,0,10,1 \\.\Scsi3: PASSIVE yes

CODE EXAMPLE 3-8 Activating a Data Path

sstm -p 3,0,10,1 -a
The operation completed successfully. (0)

sstm -p 3,0,10,1
Cntr

* Path HBA State Pref
- ------------------- ------------------- --------------- ---

3,0,10,1 \\.\Scsi3: ACTIVE yes
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Putting a Path into admin Mode

The -d Path command option puts a path into an admin mode. This option is used
to stop all I/O on a path and can be used to help isolate problems in a configuration.

This example also builds on the basic Path Report example. After issuing the Path
command with the -d option, the path becomes disabled and inactive. A warning
character(!) is also placed in the left column noting that the path is in admin mode
and not down. If the path was down, an X would be placed in the column. Only a
single character (for example, ! or x) can be placed in the left column.

Taking a Path Out of admin Mode

The -e Path command option takes a path out of admin mode. After the Path
command is issued with the -e option, the path becomes available for use.

■ For symmetric devices, the path becomes active immediately if not broken.

■ For ALUA devices, the path transitions to a state based upon information
received from the device.

■ For asymmetric devices, like the Sun StorEdge 6120, if the path is the preferred
path and auto failback is not on, the path becomes passive.

■ For asymmetric devices, like the Sun StorEdge T3+, if the path is the preferred
path and auto failback is on, the path becomes active immediately.

CODE EXAMPLE 3-9 Putting a Path Into admin Mode

sstm -p 3,0,10,1 -d
The operation completed successfully. (0)

sstm -p 3,0,10,1
Cntr

* Path HBA State Pref
- ------------------- ------------------- --------------- ---
! 3,0,10,1 \\.\Scsi3: ADMIN yes
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This status is shown by issuing the sstm command without options.

Getting Path Statistical Information

The Path command -m option returns the statistical information for a specific path.

Getting HBA Reports
The -h option returns information about a specific HBA. The specific information
returned contains the Vendor Name, Product ID, Firmware Version, Port WWN, and
Node WWN of the HBA, and the HBA driver file name.

The report also contains all the paths seen only by the particular HBA. The listing is
similar to the Path reports.

Note – The paths listed might belong to additional devices.

CODE EXAMPLE 3-10 Taking a Path Out of admin Mode

sstm -p 3,0,10,1 -e
The operation completed successfully. (0)

sstm -p 3,0,10,1
Cntr

* Path HBA State Pref
- ------------------- ------------------- --------------- ---

3,0,10,1 \\.\Scsi3: PASSIVE yes

CODE EXAMPLE 3-11 Returning Statistical Path Information

sstm -p 3,0,10,1 -m -v
Path Statistics
  Path:               3,0,10,1
  Host Requests:      6266756
  Outstanding IO:     1
  Blocks Transferred: 702227085
  IO Errors:          154
  HW Dropouts:        0
  Full Dropouts:      53
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It is also possible to enable (-e) or disable (-d) all the paths to a particular HBA. The
following example shows disabling all the paths to a particular HBA and placing the
paths in admin mode. The output after the disable command looks like the
following example:

CODE EXAMPLE 3-12 Returning Information About a Specific HBA

sstm -h \\.\Scsi4:
Name: Qlogic 2230 Fibre-Channel Adapter
Firmware Revision: 5.12
Node WWN: 00000000000000000000000000000001
Port WWN: 00000000000000000000000000000011
Driver File Name: qla23xx

Cntr
* Path HBA State  Pref
- ------------------ --------------- ------- ------

4,1,0,6 \\.\Scsi4: ACTIVE no
4,1,0,5 \\.\Scsi4: ACTIVE no
4,1,2,1 \\.\Scsi4: ACTIVE no
4,1,2,0 \\.\Scsi4: ACTIVE no
4,1,1,0 \\.\Scsi4: ACTIVE yes
4,1,1,1 \\.\Scsi4: ACTIVE yes

CODE EXAMPLE 3-13 Placing All Paths to a Particular HBA in admin Mode

sstm -h \\.\Scsi3: -d
  pathId:3,0,0,1  status:The operation completed successfully.
  pathId:3,0,10,1  status:The operation completed successfully.
  pathId:3,0,0,0  status:The operation completed successfully.
  pathId:3,0,10,0  status:The operation completed successfully.
  pathId:3,0,3,3  status:The operation completed successfully.
  pathId:3,0,21,3  status:The operation completed successfully.
  pathId:3,0,4,0  status:The operation completed successfully.
  pathId:3,0,20,0  status:The operation completed successfully.
  pathId:3,0,1,0  status:The operation completed successfully.
  pathId:3,0,13,0  status:The operation completed successfully.
  pathId:3,0,1,1  status:The operation completed successfully.
  pathId:3,0,13,1  status:The operation completed successfully.
  pathId:3,0,2,0  status:The operation completed successfully.
  pathId:3,0,5,0  status:The operation completed successfully.

The operation completed successfully. (0)
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If the verbose (-v) option is used, the output looks like the following example.

CODE EXAMPLE 3-14 Verbose Information on a Specific HBA With the sstm -v Command

sstm -h \\.\Scsi3: -v

HBA:               QLogic Corporation 2300 Fibre-Channel Adapter
Name:              \\.\Scsi3:
Firmware Revision: 3.01.20
NodeWWN:           200000e08b07642e
PortWWN:           210000e08b07642e
Driver File Name:  ql2300.sys

Cntr  In
* Path HBA State Pref Use
- ------------------- ------------------- ---------- --- ----

    ! 3,0,0,1             \\.\Scsi3:          ADMIN no   no
        state:ADMIN numOut=0 flags:0x2
    ! 3,0,10,1            \\.\Scsi3:          ADMIN yes  no
        state:ADMIN numOut=0 flags:0x6
    ! 3,0,0,0             \\.\Scsi3:          ADMIN yes  no
        state:ADMIN numOut=0 flags:0x6
    ! 3,0,10,0            \\.\Scsi3:          ADMIN no   no
        state:ADMIN numOut=0 flags:0x2
    ! 3,0,3,3             \\.\Scsi3:          ADMIN no   no
        state:ADMIN numOut=0 flags:0x2
    ! 3,0,21,3            \\.\Scsi3:          ADMIN yes  no

state:ADMIN numOut=0 flags:0x6
    ! 3,0,4,0             \\.\Scsi3:          ADMIN yes  no
        state:ADMIN numOut=0 flags:0x6
    ! 3,0,20,0            \\.\Scsi3:          ADMIN yes  no
        state:ADMIN numOut=0 flags:0x6

! 3,0,1,0 \\.\Scsi3: ADMIN yes yes
        state:ADMIN numOut=0 flags:0x7
    ! 3,0,13,0            \\.\Scsi3:          ADMIN yes  no
        state:ADMIN numOut=0 flags:0x6
    ! 3,0,1,1             \\.\Scsi3:          ADMIN yes  no
        state:ADMIN numOut=0 flags:0x6
    ! 3,0,13,1            \\.\Scsi3:          ADMIN yes  no
The operation completed successfully. (0)
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Getting Software Settings
If the sstm -P command is issued without specifying options, a report is returned
of all the software parameters plus the version of the failover software.

Changing Software Settings
The -P command, with no subcommands, returns a report of all the driver
parameters plus the failover driver version. Any of the parameters can be changed
by using their respective subcommittees.

The following sstm commands can be used to change the software settings
displayed by the sstm -P command:

CODE EXAMPLE 3-15 Returning a Report About All Software Parameters

sstm -P
Driver Public Parameters

Driver Version: 4.6.0.xx
Healthy Path Poll Rate: 30 (seconds)

Unhealthy Path Poll Rate: 30 (seconds)
Auto Failback: 0 (off)

 Log Level: 0x00 (none)

TABLE 3-2 Changing Software Settings

Supported Subcommittees Action

-P -r Restores default settings

-P -i seconds Sets healthy path poll rate (2 through 3600 seconds)

-P -b seconds Sets unhealthy path poll rate (2 through 60 seconds)

-P -l hex value Sets the log level to any of the following:
• 0x00 = no logging
• 0x01 = data path changes
• 0x02 = internal errors
• 0x04 = critical errors
• 0x08 = informational messages
• 0x10 = caution messages
• 0x1f = log everything

-P -a integer Enables or disables auto failback
• 1 = enable
• 0 = disable
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A complete list of all the command options and their explanations are found in
TABLE 3-1.

The Suspend Command
The sstm -S command blocks or stalls the return of the command and does not
return to the user until some form of path state change occurs. For example, if a path
goes down, comes back online, or is disabled, the command initiates a return to the
user.

This is a very useful command for scripting because you can create your own form
of logging by making a script that issues a sstm command default report, then an
sstm -S command in a loop.

The Cancel Command
The cancel (-C) command cancels the suspend command.

CODE EXAMPLE 3-16 The Suspend Command

sstm -S
C:>

CODE EXAMPLE 3-17 The Cancel Command

sstm -C
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CHAPTER 4

Logging Event Information

This chapter describes the events that can be logged by the Sun StorEdge Traffic
Manager package for later inspection by the Event Viewer application for the
Microsoft Windows operating system, or the system log file in the Red Hat
Enterprise Linux operating environment.

This chapter contains the following topics:

■ “Accessing the Log Files” on page 45

■ “Logging Levels” on page 46

■ “Windows Log Messages” on page 47

■ “Linux Log Messages” on page 49

Accessing the Log Files
The Sun StorEdge Traffic Manager Software monitors and tracks a variety of system
events, writing the resulting information either to the Microsoft Windows Event
Viewer, or to log files.

▼ To Access the Log Files for Microsoft Windows
2000 and 2003
Events are logged in the system log with a source of jafo for Microsoft Windows
2000 and 2003.

1. Click Start -> Settings -> Control Panel.

The Control Panel opens.
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2. In the Control Panel, double-click Administrative Tools -> Event Viewer.

▼ To Access the Log Files for Linux
The Sun StorEdge Traffic Manager Software writes status information to the
following text file:

Use a text editor or the cat command to display the contents of the Linux log file.
To view only Sun StorEdge Traffic Manager Software messages, type:

Logging Levels
This section describes the various log messages at the various logging levels as
configured by the GUI or CLI.

The following are Sun StorEdge Traffic Manager Software logging levels:

■ Informational messages – These include all critical error messages as well as non-
critical alerts. Non-critical alerts are usually when something has changed but no
functionality is lost.

■ Data path change messages – Changes to the state of a host data path.
■ Critical error messages – Unrecoverable errors, such as when the Sun StorEdge

Traffic Manager software loses access to a LUN or is out of memory.
■ Caution and internal error messages – Errors the Sun StorEdge Traffic Manager

software encounters but does not handle.

If logging level Data Path Changes is not set with the Host Preferences menu, data
path change messages are not shown.

If logging levels Data Path Changes and Critical Error messages are set with the
Host Preferences menu, only critical information is shown.

If logging levels Data Path Changes and Internal Errors are set with the Host
Preferences menu, only non-critical information is shown.

Refer to “Setting the Logging Level” on page 22 for information on setting host
preferences.

/var/log/messages

grep “JAFO” /var/log/messages
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Windows Log Messages
There are three general log messagesthat Sun StorEdge Traffic Manager writes to the
system log file. The messages and an explanation of the variable fields are:

■ JAFO: Driver Loaded. Major version: %VERSION Minor version:
%VERSION Point version: %VERSION Release version:
%VERSION.

■ JAFO: Path state changed. Lun: %LUN_NAME Path: %PATH_NAME -
Old State: %PATH_STATE New State: %PATH_STATE Reason:
%REASON.

■ JAFO: Lun state changed. Lun: %LUN_NAME - Old State:
%LUN_STATE New State:%LUN_STATE.

The variable fields in the general log message are described in TABLE 4-1.

TABLE 4-1 Description of the Log Messages Variable Fields

Variable Field Description

LUN_NAME Replaced with \\.PhysicalDisk#

LUN_STATE Replaced with one of the following states:
• WAITING_FOR_ACTIVE_PATH

• DOWN

• DOWN_GRACE

• UP

• TRANSITIONING
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The Sun StorEdge Traffic Manager software settings for logging level using the
command line interface or graphical user interface effects the messaging in TABLE 4-1.
The logging levels that affect Microsoft Windows are Internal, Critical, and Path
status changes. When internal logging is enabled, state changes ending in
Transitioning occur.

■ Internal error messages normally end in a state of TRANSITIONING, UNKNOWN,
or LUN_HARDWARE_ERROR

■ Critical error messages normally end in a state of DOWN or REMOVED
■ Path change messages normally end in a state of UP_ACTIVE, UP_STANDBY or

ADMIN.

PATH_NAME Replaced with #,#,#,#

PATH_STATE Replaced with one of the following states:
• ADMIN

• DOWN

• REMOVED

• TRANSITIONING

• UP_ACTIVE

• UP_PASSIVE

• STANDBY

REASON Replaced with one of the following (NOTE: Reason codes are
primarily for the expert user and support):
• init – New path addition
• recovered – Path returning from a removed state
• io failure – I/O error. This reason is not exposed to upper-

level drivers. It is routed down available paths when possible.
• IRP_MN_SURPRISE_REMOVAL – A lower-level driver removed the

path check. A state occurred that caused the driver to determine
this path might be in a state of TRANSITIONING.

• failover:success – Asymmetric device failover was successful
• failover:failure – Asymmetric device failover failed
• #_#_# -%NTSTATUS, %SRB_STATUS, %SCSISTAT – are

Microsoft Windows I/O status and can be looked up at
http://msdn.microsoft.com.

• #_#_#_#_# – same as the proceeding bullet except the fourth and
fifth values are SCSI and ASC/ASCQ and can be looked up at
http://www.t10.org.

TABLE 4-1 Description of the Log Messages Variable Fields (Continued)

Variable Field Description
48 Sun StorEdge Traffic Manager 4.6 Software User’s Guide • September 2004



Linux Log Messages
This section describes the various Linux specific log messages at the various logging
levels as configured by the GUI or CLI.

TABLE 4-2 Log Informational Messages

Message Message Explanation Information in the Message

Driver loaded The operating system has loaded the
Traffic Manager driver.

• Major version
• Minor version
• Point version
• Release version

TABLE 4-3 Log Data Path Changes and Log Critical Errors

Message Message Explanation Information in the Message

Path state change This message is logged when the state
of any path changes for critical
reasons.

Old state and new state. Valid values are:
• Active

• Passive

• Down

• Standby

• Path name

• Unique LUN ID

Reason string, valid values are:
• I/O status—state change as a result

of I/O status. There will also be detail
data consisting of operating system
specific SCSI status.

• User initiated—state change as a
result of user initiated action, for
example, activate or disable

• AutoFailback initiated—state
change as a result of auto failback action
• Failover initiated—state change
due to the need for passive to active
action
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TABLE 4-4 Critical Log Messages

Message Message Explanation Information in the Message

Failover command sent
to

This message is logged when the state
of any path changes for critical
reasons and the logging levels Log
Data Path Changes is set in addition
to Log Critical Error.

• Path name on which the failover
command was sent

• Unique LUN ID
• Unique array ID
• Controller ID
Reason string, valid values are:
• User initiated—failover command

sent as a result of user initiated action.
For example, activate or disable.

• AutoFailBack initiated—failover
command sent as a result of auto restore
failback action
• Failover initiated—failover

command sent due to the need for
passive to active action

TABLE 4-5 Log Internal Messages

Message Message Explanation Information in the Message

LUN state changed This message is logged when any
noncritical LUN state changes occur.

Old LUN state and new LUN state. Valid
values are:
• Unknown
• Up
• Transition
• Down_Grace
• Down
• Removed

• LUN unique ID
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TABLE 4-6 Log Data Path Changes and Log Internal Errors

Message Message Explanation Information in the Message

Path state changed to This message is logged when the state
of any path changes for critical or
non-critical reasons and the logging
levels Log Data Path Changes and
Log Internal Errors are set.

Old state and new state. Valid values are:
• Unknown

• Active

• Passive

• Transition

• Down

• Admin

• Removed

• Standby

• Path name

• Unique LUN ID

Reason string, valid values are:
• IO status—state change as a result of

I/O status. There will also be detail
data consisting of operating system
specific SCSI status.

• Device added—state change as a
result of a new path

• Device removed—state change as a
result of a path removed

• User initiated—state change as a
result of a user initiated action. For
example, activate or disable.

• AutoFailBack initiated—state
change as a result of auto failback
action

• Failover initiated—state change
due to a need for passive to active
action
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CHAPTER 5

Error Return Messages

The following table contains all the return messages from the command line
interface to the initiator of the command. To obtain a number value for these returns
echo %ERRORLEVEL% after the sstm command completes. The echo response will be
integers.

TABLE 5-1 Error Return Codes and Meanings

Code Meaning

00 The operation completed successfully.

100 The operation contained an invalid parameter.

101 An I/O error occurred during the operation.

102 The operation did not complete within the specified time.

103 The specified HBA could not be found or does not exist.

104 The specified device could not be found or does not exist.

105 The specified LUN could not be found or does not exist.

106 The specified path could not be found or does not exist.

107 The specified device was busy and could not accept the request.

108 The host OS has no memory left to allocate.

109 An internal error was encountered during the operation.

110 No supported devices were detected.

111 There are no alternate paths available to the device.

112 The specified path could not be enabled.

113 The specified path is already the active path.

114 The specified path is down or offline and is currently not available.

115 The selection of the specified path failed.
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116 An invalid state change was attempted for the specified path.

117 The preferred path is down or offline and is currently not available.

118 An illegal or out-of-range command was specified.

119 The specified SCSI pass-through command failed.

120 The buffer specified was too small for the operation.

121 The restore operation failed.

122 A reservation conflict was encountered during the operation.

123 The operation is not supported.

124 A reboot is required.

125 The operation failed for some paths.

TABLE 5-1 Error Return Codes and Meanings (Continued)

Code Meaning
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